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Preface

NOTICE TO CUSTOMERS

document.

All documentation becomes dated, and this manual is no exception. Microchip tools and
documentation are constantly evolving to meet customer needs, so some actual dialogs
and/or tool descriptions may differ from those in this document. Please refer to our web site
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each
page, in front of the page number. The numbering convention for the DS number is
“DSXXXXXA”, where “XXXXX” is the document number and “A” is the revision level of the

For the most up-to-date information on development tools, see the MPLAB® IDE on-line help.
Select the Help menu, and then Topics to open a list of available on-line help files.

INTRODUCTION

This chapter contains general information that will be useful to know before using
PICKkit™ 3 programmer/debugger. Items discussed include:

Document Layout

Conventions Used in this Guide

Warranty Registration

Recommended Reading

The Microchip Web Site

Development Systems Customer Change Notification Service
Customer Support

© 2009 Microchip Technology Inc. DS51795A-page 1




PICkit™ 3 User’s Guide

DOCUMENT LAYOUT

This document describes how to use the PICkit 2as a development tool to emulate and

debug firmware on a target board. The manual layout is as follows:

* Chapter 1. Overview — An overview of the PICkit 3 programmer/debugger.

e Chapter 2. Theory of Operation — A simplified description of how the PICkit 3
programmer/debugger works.

« Chapter 3. Installation — How to install the PICkit 3 programmer/debugger.

» Chapter 4. General Setup — Provides Instructions on how to get started using the
PICkit 3 programmer/debugger to program supported devices.

« Chapter 5. PICKit 3 Debug Express — Provides basic information on using the
PICkit™ 3 Debug Express.

« Chapter 6. Troubleshooting First Steps — Begins the troubleshooting process
by identifying first steps and common reasons for problems with debugging.

e Chapter 7. Frequently Asked Questions (FAQs) — Provides information on
solving common problems.

e Chapter 8. Error Messages — Provides specific error messages and general
corrective actions.

* Chapter 9. Debugger Function Summary — Summarizes the available
debugging functions.

e Chapter 10. Hardware Specification — Details hardware and electrical
specifications for the PICkit 3.

e Appendix A. PICKit 3 Schematics — Provides hardware schematic diagrams for
the PICkit 3 programmer/debugger.

* Appendix B. Operational Advisory — Addresses operational issues to be
considered when designing applications.

DS51795A-page 2 © 2009 Microchip Technology Inc.
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CONVENTIONS USED IN THIS GUIDE

The following conventions may appear in this documentation:

DOCUMENTATION CONVENTIONS

dialog

Description Represents Examples
Arial font:
Italic Referenced books MPLAB® IDE User’s Guide
Emphasized text ...is the only compiler...
Initial caps A window the Output window
A dialog the Settings dialog
A menu selection select Enable Programmer
Quotes A field name in a window or | “Save project before build”

Underlined, italic with right A menu path File>Save
angle bracket
Bold characters A dialog button Click OK

Atab

Click the Power tab

Text in angle brackets < >

A key on the keyboard

Press <Enter>, <F1>

Courier New font:

Plain Sample source code #define START
Filenames autoexec.bat
File paths c:\mcc18\h
Keywords _asm, _endasm, static
Command-line options -Opa+, -Opa-
Bit values 0, 1
Constants OxFF, 'A’
Italic A variable argument file.o, where file can be

any valid filename

Square brackets [ ]

Optional arguments

mpasmwin [options]
file [options]

Curly brackets and pipe
character: {| }

Choice of mutually exclusive
arguments; an OR selection

errorlevel {0]|1}

Ellipses...

Replaces repeated text

var name [,
var name...]

Represents code supplied by
user

void main (void)
{
}

© 2009 Microchip Technology Inc.
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WARRANTY REGISTRATION

Please complete the enclosed Warranty Registration Card and mail it promptly.
Sending in the Warranty Registration Card entitles users to receive new product
updates. Interim software releases are available at the Microchip web site.

RECOMMENDED READING

This user's guide describes how to use PICkit 2. Other useful documents are listed
below. The following Microchip documents are available and recommended as
supplemental reference resources.

44-Pin Demo Board User’s Guide (DS41296)

Consult this document for instructions on how to use the 44-Pin demo board as a
development tool to emulate and debug firmware on a target board.

Low Pin Count Demo Board User’s Guide (DS51556)

Consult this document for instructions on how to use Microchip Technology'’s low pin
count device (8-pin, 14-pin and 20-pin). This document includes a series of tutorials.

MPLAB® IDE User’s Guide/Help (DS51519)

Consult this document for more information pertaining to the installation and features
of the MPLAB Integrated Development Environment (IDE) software. An on-line Help
version is also available.

In-Circuit Serial Programmer™ (ICSP™) Guide (DS30277)

This document contains helpful design guidelines for successful ICSP programming. It
includes application notes on hardware designs and the ICSP programming
specifications.

MPASM™ Assembler, MPLINK™ Object Linker, MPLIB™ Object Librarian User’s
Guide (DS33014)

Describes how to use the Microchip PIC® MCU assembler (MPASM assembler), linker
(MPLINK linker), and librarian (MPLIB librarian).

README for PICKit™ 3 Debug Express

For the latest information on using the PICkit 3 Debug Express, read the “Readme for
PICkit 3.htm"file (an HTML file) in the Readmes subdirectory of the MPLAB IDE
installation directory. The Readme file contains updated information and known issues
that may not be included in this user’s guide.

PICKit™ 3 Debug Express C18 Lessons

These tutorials guide you through using the PICkit 3 Debug Express with the MPLAB
C Compiler for PIC18 MCU's. They are available on the MPLAB IDE CDROM and on
the Microchip web site.

Readme Files

For the latest information on using other tools, read the tool-specific Readme files in
the Readmes subdirectory of the MPLAB IDE installation directory. The Readme files
contain updated information and known issues that may not be included in this user’s
guide.

DS51795A-page 4 © 2009 Microchip Technology Inc.
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THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web
site is used as a means to make files and information easily available to customers.
Accessible by using your favorite internet browser, the web site contains the following
information:

* Product Support — Data sheets and errata, application notes and sample
programs, design resources, user’s guides and hardware support documents,
latest software releases and archived software

« General Technical Support — Frequently Asked Questions (FAQs), technical
support requests, online discussion groups, Microchip consultant program
member listing

» Business of Microchip — Product selector and ordering guides, latest Microchip
press releases, listing of seminars and events, listings of Microchip sales offices,
distributors and factory representatives

DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE

Microchip’s customer notification service helps keep customers current on Microchip
products. Subscribers will receive e-mail natification whenever there are changes,
updates, revisions or errata related to a specified product family or development tool of
interest.

To register, access the Microchip web site at www.microchip.com, click on Customer
Change Notification and follow the registration instructions.

The Development Systems product group categories are:

e Compilers — The latest information on Microchip C compilers, assemblers, linkers
and other language tools. These include all MPLAB C compilers; all MPLAB
assemblers (including MPASM™ assembler); all MPLAB linkers (including
MPLINK™ object linker); and all MPLAB librarians (including MPLIB™ object
librarian).

« Emulators — The latest information on Microchip in-circuit emulators.These
include the MPLAB REAL ICE™, MPLAB ICE 2000 in-circuit emulators

 In-Circuit Debuggers — The latest information on the Microchip in-circuit
debuggers. These include the MPLAB ICD 2, ICD 3, PICkit™ 2 and PICkit™ 3.

« MPLAB® IDE - The latest information on Microchip MPLAB IDE, the Windows®
Integrated Development Environment for development systems tools. This list is
focused on the MPLAB IDE, MPLAB IDE Project Manager, MPLAB Editor and
MPLAB SIM simulator, as well as general editing and debugging features.

* Programmers — The latest information on Microchip programmers. These include
the MPLAB PM3 device programmer and the PICSTART® Plus, PICKit 2 and
PICkit 3 development programmers.

© 2009 Microchip Technology Inc. DS51795A-page 5
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CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

« Distributor or Representative

* Local Sales Office

 Field Application Engineer (FAE)

» Technical Support

Customers should contact their distributor, representative or field application engineer
(FAE) for support. Local sales offices are also available to help customers. A listing of

sales offices and locations is included in the back of this document. See our web site
for a complete, up-to-date listing of sales offices.

Technical support is available through the web site at: http://support.microchip.com.

DS51795A-page 6 © 2009 Microchip Technology Inc.


http://support.microchip.com

MICROCHIP PICkit™ 3 USER’S GUIDE
Part 1 — Getting Started

(O F= T o) (= i I O A =T VTSP 9
Chapter 2. Theory of OPeration ........cooovviiiieiiiiiiiii e e e e e e e e e eeeeanenes 15
(O F= o) (=T g T 10 153 = 11 = U o o [PPSR 23
Chapter 4. GENEral SELUP ...uuuuuueiiii e et e e e e e e e e e et e a e e e e e aeeeeees 27

Chapter 5. PICKit 3 Debug Express

© 2009 Microchip Technology Inc. DS51795A-page 7



PICkit™ 3 User’s Guide

NOTES:
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Chapter 1. Overview

1.1 INTRODUCTION

An overview of the PICkit 3 programmer/debugger system is given.

« PICkit 3 Programmer/Debugger Defined

* How the PICkit 3 Programmer/Debugger Helps You
« PICkit 3 Programmer/Debugger Components

» Device and Feature Support

1.2 PICKIT 3 PROGRAMMER/DEBUGGER DEFINED

The PICKit 3 programmer/debugger (see Figure 1-1) is a simple, low-cost in-circuit
debugger that is controlled by a PC running MPLAB IDE (v8.20 or greater) software on
a Windows® platform. The PICKkit 3 programmer/debugger is an integral part of the
development engineer’s toolsuite. The application usage can vary from software
development to hardware integration.

The PICkit 3 programmer/debugger is a debugger system used for hardware and
software development of Microchip PIC® microcontrollers (MCUs) and dsPIC® Digital
Signal Controllers (DSCs) that are based on In-Circuit Serial Programming™ (ICSP™)
and Enhanced In-Circuit Serial Programming 2-wire serial interfaces. In addition to
debugger functions, the PICkit 3 programmer/debugger system also may be used as a
development programmer.

The debugger system executes code like an actual device because it uses a device
with built-in emulation circuitry, instead of a special debugger chip, for emulation. All
available features of a given device are accessible interactively, and can be set and
modified by the MPLAB IDE interface.

The PICkit 3 debugger was developed for emulating embedded processors with debug
facilities. The PICKit 3 features include:

 Full-speed USB support using Windows standard drivers

* Real-time execution

» Processors run at maximum speeds

* Built-in over-voltage/short circuit monitor

« Low voltage to 5V (1.8-5V range)

» Diagnostic LEDs (power, active, status)

» Read/write program and data memory of microcontroller

 Erase of all memory types (EEPROM, ID, configuration and program) with
verification

 Peripheral freeze at breakpoint

Note: The PICkit 3 is intended for development programming. For production
programming, please consider the MPLAB PM3 device programmer or
other third party programmers designed for a production environment.

© 2009 Microchip Technology Inc. DS51795A-page 9
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FIGURE 1-1: PICkit™ 3 MCU PROGRAMMER/DEBUGGER

N

MICROCHIP

Legend:
1 - Lanyard Connection
2 — USB Port Connection
3 — Pin 1 Marker
4 — Programming Connector
5 — Status LEDs
6 — Push Button (future use)

1.2.1 Lanyard Connection

A convenient lanyard connection is available on the programmer.

1.2.2 USB Port Connection

The USB port connection is a USB mini-B connector. Connect the PICkit 3 to the PC using
the supplied USB cable.

1.2.3 Pin 1 Marker

This marker designates the location of pin 1 for proper connector alignment.

124 Programming Connector

The programming connector is a 6-pin header (0.100" spacing) that connects to the
target device. See the pinout specification in Figure 1-2.

DS51795A-page 10 © 2009 Microchip Technology Inc.



Overview

FIGURE 1-2: PICKIT™ 3 PROGRAMMER CONNECTOR PINOUT

Pin 1 Indicator

Pin Description*

1 = VPP/MCLR

2 = VDD Target

3 =Vss (ground)

4 = |CSPDAT/PGD
5 = ICSPCLK/PGC
6 = LVP

>

o wWNPE

* The 6-pin header (0.100" spacing) accepts 0.025" square pins.

Note: The programming connector pin functions are different for programming
Serial EEPROMS and HCS devices. See the ReadMe file for the PICkit 3
(Help>Readme) included with the MPLAB IDE software for these pinouts.

1.2.5 Status LEDs

The Status LEDs indicate the status of the PICkit 3.

1. Power (green) — Power is supplied to the PICkit 3 via the USB port.

2. Active (blue) — The PICkit 3 has connection to the PC USB port and the
communication link is active.

3. Status:
Busy (yellow) — The PICKkit 3 is busy with a function in progress, such as
programming.
Error (red) — The PICkit 3 has encountered an error.

1.3 HOW THE PICKIT 3 PROGRAMMER/DEBUGGER HELPS YOU

The PICkit 3 programmer/debugger allows you to:

« Debug your application on your own hardware in real time
» Debug with hardware breakpoints

« Set breakpoints based on internal events

< Monitor internal file registers

« Emulate at full speed

» Program your device

© 2009 Microchip Technology Inc. DS51795A-page 11
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1.4 PICKIT 3 PROGRAMMER/DEBUGGER COMPONENTS

The components of the PICkit 3 programmer/debugger system are:

1. PICKkit 3 with indicator lights for power, activity and status.

2. USB cable to provide communications between the debugger and a PC and to
provide power to the debugger.

3. CD-ROM with MPLAB IDE software and on-line documentation.

FIGURE 1-3: BASIC DEBUGGER SYSTEM

Indicator
Lights

PICkit™ 3

5

®

=

n

-
&

ae

I

o

USB Cable to PC

To Target Board

Additional hardware that may be ordered separately:

« PICKkit 3 Debug Express Kit which includes:
- a 44-pin demo board with a PIC18F45K20 MCU
- free version of MPLAB C Compiler for PIC18 MCUs
- easy-to-understand lessons and tutorials
- other software utilities, examples with source code and full documentation
 Transition socket
* ICD headers
* MPLAB IDE processor extension kits

DS51795A-page 12 © 2009 Microchip Technology Inc.
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DEVICE AND FEATURE SUPPORT

Table 1-1 and Table 1-2 show the support for devices and device features.

TABLE 1-1: 16-BIT (DATA MEMORY) DEVICES

Feature

dsPIC33F,
PIC24F/H

dsPIC30F
sMps®

dsPIC30F

Reset application

(@]

(@)

(@]

Run, Halt

Single step

Animate

Full-speed emulation

Hardware breakpoints

Peripheral freeze®

Break on data fetch or write

Break on stack overflow

Stopwatch

Pass counter

WDT overflow

Standard speed communication

Processor Pak

TIOO|O(O|Z[0/0[0|0[0|0|0

TIOO|O[O|Z[0|0[0|0[O0|0|0

Z|ojZ|0(Z|Z2[0/0[0|0[0|0|0O

Legend:
C = Current support
D = Support dependent on device

F = No support now, but planned in the future

N = Support not available

Note 1: Current Switch Mode Power Supply (SMPS) devices: dsPIC30F1010/2020/2023.
2. This feature operates differently depending on the selected device.

© 2009 Microchip Technology Inc.
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TABLE 1-2: 8-BIT (DATA MEMORY) DEVICES
PIC18F,
Feature PIC18FXXJ PIC18F Enh, PIC12F, PIC16F
PIC18FXXK

Reset application C C (03
Run, Halt C C C
Single step C C C
Animate C C C
Full-speed emulation C C C
Hardware breakpoints C C C
Peripheral freeze(®) c c c
Break on data fetch or write C C N
Break on stack overflow C C N
Stopwatch C N N
Pass counter C C N
WDT overflow C N N
Standard speed communication C C (03
Processor Pak F F F

Legend:
C = Current support

F = No support now, but planned in the future

N = Support not available

Note 1: This feature operates differently depending on the selected device.

DS51795A-page 14
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Chapter 2. Theory of Operation

2.1 INTRODUCTION

A simplified description of how the PICkit 3 programmer/debugger system works is
provided here. It is intended to provide enough information so a target board can be
designed that is compatible with the debugger for both emulation and programming
operations. The basic theory of in-circuit emulation and programming is described so
that problems, if encountered, are quickly resolved.

 PICkit 3 vs. PICKit 2

« Debugger to Target Communication

e Communication Connections

» Debugging

« Requirements for Debugging

* Programming

« Resources Used by the Debugger

2.2  PICkit 3 VS. PICKit 2

The PICkit 3 programmer/debugger system is similar in function to the PICkit 2
in-circuit debugger system. Similarities of the two debuggers include:

» Powered via USB cable to PC

» Provides a programmable voltage power supply

The PICKit 3 differs from the PICkit 2 by providing:

« Extended EE program image space (512 Kbytes)

 True voltage reference

* Increased voltage range (1.8-5V VDD; 1.8-14V VpPP)

2.3 DEBUGGER TO TARGET COMMUNICATION

The debugger system configurations are discussed in the following sections.

CAUTION

Do not change hardware connections while the PICkit 3 or target is powered.

Standard ICSP Device Communication

The debugger system can be configured to use standard ICSP communication for both
programming and debugging functions. This 6-pin connection is the same one used by
the PICkit 2 programmer/debugger.

© 2009 Microchip Technology Inc. DS51795A-page 15
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The modular cable can be either (1) inserted into a matching socket at the target, where
the target device is on the target board (Figure 2-1), or (2) inserted into a standard
adapter/header board combo (available as a Processor Pak), which in then plugged
into the target board (Figure 2-2).

Note: Older header boards used a 6-pin (RJ-11) connector instead of an 8-pin
connector, so these headers may be connected to the debugger with the
AC164110 ICSP adapter.

For more on standard communication, see Chapter 10. “Hardware Specification”.

FIGURE 2-1: STANDARD DEBUGGER SYSTEM — DEVICE WITH
ON-BOARD ICE CIRCUITRY
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FIGURE 2-2: STANDARD DEBUGGER SYSTEM - ICE DEVICE
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24 COMMUNICATION CONNECTIONS
24.1 Communication Target Connections

2.4.1.1 USING SINGLE IN-LINE CONNECTOR

Use the 6-pin in-line connector between the PICkit 3 programmer/debugger and the
target board connector. See Figure 2-1. Also see Table 2-1 and
Section 10.6 “Standard Communication Hardware”.

TABLE 2-1: TARGET CONNECTOR PINOUT
Connector Pin Microcontroller Pin

1 MCLR/VPP
VDD

Ground
PDG (ICSPDAT)
PGC (ICSPCLK)

LVP

Ol |W|DN

2.4.1.2 USING AN ADAPTER

Use the AC164110 adapter between the PICkit 3 programmer/debugger and the target
device with the modular interface (six conductor) cable. The pin numbering for the
connector is shown from the bottom of the target PC board in Figure 2-3.

Note: Cable connections at the debugger and target are mirror images of each
other, i.e., pin 1 on one end of the cable is connected to pin 6 on the other
end of the cable. See Section 10.6.2.3 “Modular Cable Specification”.

FIGURE 2-3: STANDARD RJ-11 CONNECTION AT TARGET

Target
Connector

O ® PGD
2 /o P

VDD ——___
© 0 ©
) °/PGC

___ 1 3\5 Target
VPP/MCLR Vs PC Board

Bottom Side

2.4.2 Target Connection Circuitry

Figure 2-4 shows the interconnections of the PICkit 3 programmer/debugger to the
connector on the target board. The diagram also shows the wiring from the connector
to a device on the target PC board. A pull-up resistor (usually around 10 kQ) is
recommended to be connected from the VPP/MCLR line to VDD so that the line may be
strobed low to reset the device.
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FIGURE 2-4: STANDARD CONNECTION TARGET CIRCUITRY
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2.4.3 Target Powered

In the following descriptions, only three lines are active and relevant to core debugger
operation: pins 1 (VPP/MCLR), 5 (PGC) and 4 (PGD). Pins 2 (VDD) and 3 (Vss) are
shown on Figure 2-4 for completeness. PICKkit 3 has two configurations for powering
the target device: internal debugger and external target power.

The recommended source of power is external and derived from the target application.
In this configuration, target VDD is sensed by the debugger to allow level translation for
the target low voltage operation. If the debugger does not sense voltage on its VDD line
(pin 2 of the interface connector), it will not operate.

24.4 Debugger Powered

The internal debugger power is limited to 30 mA. This may be of benefit for very small
applications that have the device VDD separated from the rest of the application circuit
for independent programming, but is not recommended for general usage as itimposes
more current demands from the USB power system derived from the PC.

Not all devices have the AVDD and AVss lines, but if they are present on the target
device, all must be connected to the appropriate levels in order for the debugger to
operate. They cannot be left floating.

In general, it is recommended that all VDD/AVDD and Vss/AVss lines be connected to
the appropriate levels. Also, devices with a VCAP line (PIC18FXXJ for example) should
be connected to the appropriate capacitor or level.

Note: The interconnection is very simple. Any problems experienced are often
caused by other connections or components on these critical lines that
interfere with the operation of the PICkit 3 programmer/debugger, as
discussed in the following section.
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2.4.5 Circuits That Will Prevent the Debugger From Functioning

Figure 2-5 shows the active debugger lines with some components that will prevent the
PICkit 3 debugger system from functioning.

FIGURE 2-5: IMPROPER CIRCUIT COMPONENTS
VPP/MCLR
z
3@
PGC g -
PGD
Interface
No! Connector

Specifically, these guidelines must be followed:
« Do not use pull-ups on PGC/PGD - they will disrupt the voltage levels, since
these lines have 4.7 kQ pull-down resistors in the debugger.

« Do not use capacitors on PGC/PGD - they will prevent fast transitions on data
and clock lines during programming and debug communications.

» Do not use capacitors on MCLR — they will prevent fast transitions of VPp. A
simple pull-up resistor is generally sufficient.

« Do not use diodes on PGC/PGD - they will prevent bidirectional communication
between the debugger and the target device.

2.5 DEBUGGING

There are two steps to using the PICkit 3 programmer/debugger system as a debugger.
The first requires that an application be programmed into the target device (usually with
the PICKit 3 itself). The second uses the internal in-circuit debug hardware of the target
Flash device to run and test the application program. These two steps are directly
related to the MPLAB IDE operations:

1. Program the code into the target and activate special debug functions (see the
next section for details).
2. Use the debugger to set breakpoints and run.

If the target device cannot be programmed correctly, the PICKkit 3
programmer/debugger will not be able to debug.

Figure 2-6 shows the basic interconnections required for programming. Note that this
is the same as Figure 2-4, but for the sake of clarity, the Vbb and Vss lines from the
debugger are not shown.
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FIGURE 2-6: PROPER CONNECTIONS FOR PROGRAMMING
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A simplified diagram of some of the internal interface circuitry of the PICkit 3
programmer/debugger is shown. For programming, no clock is needed on the target
device, but power must be supplied. When programming,